Important Notice

Due to the nature of wireless communications, transmission and reception of data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or be totally lost. Although significant delays or losses of data are rare when wireless devices such as the Sierra Wireless modem are used in a normal manner with a well-constructed network, the Sierra Wireless modem should not be used in situations where failure to transmit or receive data could result in damage of any kind to the user or any other party, including but not limited to personal injury, death, or loss of property. Sierra Wireless accepts no responsibility for damages of any kind resulting from delays or errors in data transmitted or received using the Sierra Wireless modem, or for failure of the Sierra Wireless modem to transmit or receive such data.

Safety and Hazards

Do not operate the Sierra Wireless modem:
- In areas where blasting is in progress
- Where explosive atmospheres may be present
- Near medical equipment
- Near life support equipment, or any equipment that may be susceptible to any form of radio interference. In such areas, the Sierra Wireless modem MUST BE POWERED OFF. The Sierra Wireless modem can transmit signals that could interfere with this equipment.

Do not operate the Sierra Wireless modem in any aircraft, whether the aircraft is on the ground or in flight. In aircraft, the Sierra Wireless modem MUST BE POWERED OFF. When operating, the Sierra Wireless modem can transmit signals that could interfere with various onboard systems.

Note: Some airlines may permit the use of cellular phones while the aircraft is on the ground and the door is open. The Sierra Wireless modem may be used at this time.

The driver or operator of any vehicle should not operate the Sierra Wireless modem while in control of a vehicle. Doing so will detract from the driver or operator’s control and operation of that vehicle. In some states and provinces, operating such communications devices while in control of a vehicle is an offence.
Limitation of Liability

The information in this manual is subject to change without notice and does not represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO USE ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS AFFILIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY ARE FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its affiliates aggregate liability arising under or in connection with the Sierra Wireless product, regardless of the number of events, occurrences, or claims giving rise to liability, be in excess of the price paid by the purchaser for the Sierra Wireless product.

Patents

Portions of this product may be covered by some or all of the following US patents:
5,515,013  5,629,960  5,845,216  5,847,553  5,878,234
5,890,057  5,929,815  6,169,884  6,191,741  6,199,168
6,339,405  6,359,591  6,400,336  6,561,851
6,643,501  6,653,979  6,697,030  6,785,830  6,845,249
6,847,830  6,876,697  6,879,585  6,886,049  6,968,171
6,985,757  7,023,878, 7,053,843 7,106,569 7,145,267
7,200,512  7,287,162  7,295,171 D442,170 D459,303
D559,256  D560,911
and other patents pending.

This product includes technology licensed from:

QUALCOMM
3G CDMA

Licensed by QUALCOMM Incorporated under one or more of the following United States patents and/or their counterparts in other nations:
4,901,307  5,056,109  5,101,501  5,109,390  5,228,054
5,267,261  5,267,262  5,337,338  5,414,796  5,416,797
5,490,165  5,504,773  5,506,865  5,511,073  5,535,239
5,544,196  5,568,483  5,600,754  5,657,420  5,659,569
5,710,784  5,778,338

Manufactured or sold by Sierra Wireless Inc. or its Licensees under one or more patents licensed from InterDigital Group.

Copyright

©2008 Sierra Wireless. All rights reserved.
Trademarks

AirCard and “Heart of the Wireless Machine” are registered trademarks of Sierra Wireless. Watcher is a trademark of Sierra Wireless, registered in the European Community. Sierra Wireless, the Sierra Wireless logo, TRU-Install, TRU-Locate, and the red wave design are trademarks of Sierra Wireless.

Windows® is a registered trademark of Microsoft Corporation.

Mac OS is a trademark of Apple Inc., registered in the U.S. and other countries.

PC Card and ExpressCard are trademarks of PCMCIA.

QUALCOMM® is a registered trademark of QUALCOMM Incorporated. gpsOne is a trademark of QUALCOMM Incorporated.

InstallShield® is a registered trademark of Macrovision Corporation in the United States of America and/or other countries.

Other trademarks are the property of the respective owners.

Contact Information

<table>
<thead>
<tr>
<th>Sales Desk:</th>
<th>Phone: 1-604-232-1488</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours:</td>
<td>8:00 AM to 5:00 PM Pacific Time</td>
</tr>
<tr>
<td>E-mail:</td>
<td><a href="mailto:sales@sierrawireless.com">sales@sierrawireless.com</a></td>
</tr>
<tr>
<td>Post:</td>
<td>Sierra Wireless 13811 Wireless Way Richmond, BC Canada V6V 3A4</td>
</tr>
<tr>
<td>Fax:</td>
<td>1-604-231-1109</td>
</tr>
<tr>
<td>Web:</td>
<td><a href="http://www.sierrawireless.com">www.sierrawireless.com</a></td>
</tr>
</tbody>
</table>

For up-to-date product descriptions, documentation, application notes, firmware upgrades, troubleshooting tips, and press releases, visit www.sierrawireless.com.
Table of Contents

Introducing the Compass 597 USB modem ................................. 9
  Welcome .......................................................... 9
  Feature summary .................................................. 10
  Wireless modem ................................................... 10
    Windows ......................................................... 10
    Mac ............................................................ 10
  TRU-Install ........................................................ 10
  TRU-Locate ........................................................ 11
  CDMA 3G services ................................................ 11
  Additional Compass USB modem features ............................ 12
Package contents ......................................................... 13
System components ..................................................... 13
  Your host computing device ....................................... 13
  The Compass 597 USB modem ..................................... 13
  The modem drivers and enabling software ....................... 14
  CDMA service provider account ................................ 14
  The CDMA wireless network ..................................... 15
Care and maintenance of your modem .................................... 15

Getting Started .......................................................... 17
  The Compass 597 software ....................................... 17
  Account activation and configuration ............................ 17

Installation .............................................................. 19
  System requirements ................................................ 19
    Mac requirements ................................................ 20
  Installing on a Windows computer ................................ 20
  Installing on a Mac computer .................................... 22
USB modem insertion and removal .............................................. 22
  Inserting the modem ......................................................... 22
  Removing the modem ......................................................... 23
    Windows ........................................................................... 23
    Mac .............................................................................. 24
Using the USB extension cable ................................................... 24
Using a microSD card .............................................................. 24
  Inserting the microSD card .................................................. 25
  Removing the microSD card .................................................. 25
Using an external antenna ....................................................... 26

Activation ............................................................................. 27
  Account configuration procedures ...................................... 27
  Activating on a Windows computer .................................... 27
    Activation Wizard .......................................................... 27
    Manual activation .......................................................... 28
  Activating on a Mac computer ............................................ 28
    Activation Assistant ...................................................... 30

Watcher Basics (Windows) ....................................................... 31
  Starting and closing Watcher ............................................. 31
  Components of the Watcher window .................................. 32
    Window controls .......................................................... 33
    Docking ........................................................................ 33
    Always On Top .............................................................. 33
  Interpreting icons .............................................................. 34
    Connection Status Area ................................................. 34
    Call Status Area ............................................................ 35
    Indicator area .............................................................. 36
    Minimized icons .......................................................... 36
  GPS Monitor window .......................................................... 37
  Online Help ....................................................................... 38
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warranty</td>
<td>38</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>39</td>
</tr>
<tr>
<td><strong>Watcher Lite Basics (Mac)</strong></td>
<td>41</td>
</tr>
<tr>
<td>Starting and closing Watcher Lite</td>
<td>41</td>
</tr>
<tr>
<td>Watcher Lite window</td>
<td>42</td>
</tr>
<tr>
<td>Connection states</td>
<td>43</td>
</tr>
<tr>
<td>No device detected</td>
<td>43</td>
</tr>
<tr>
<td>Not activated</td>
<td>43</td>
</tr>
<tr>
<td>Updating User Profile</td>
<td>43</td>
</tr>
<tr>
<td>Disconnected</td>
<td>43</td>
</tr>
<tr>
<td>Connecting</td>
<td>43</td>
</tr>
<tr>
<td>Connected</td>
<td>44</td>
</tr>
<tr>
<td>Device is Locked</td>
<td>44</td>
</tr>
<tr>
<td>Determining the type of coverage</td>
<td>44</td>
</tr>
<tr>
<td>Watcher Lite menu options</td>
<td>44</td>
</tr>
<tr>
<td>Connecting to the network</td>
<td>45</td>
</tr>
<tr>
<td>Viewing the amount of data transferred</td>
<td>45</td>
</tr>
<tr>
<td>Ending a connection</td>
<td>45</td>
</tr>
<tr>
<td>Displaying your phone number and ESN</td>
<td>45</td>
</tr>
<tr>
<td>Security</td>
<td>45</td>
</tr>
<tr>
<td>Initial lock code</td>
<td>46</td>
</tr>
<tr>
<td>Warning regarding the lock code</td>
<td>46</td>
</tr>
<tr>
<td>When the modem is locked</td>
<td>46</td>
</tr>
<tr>
<td>Locking the modem</td>
<td>46</td>
</tr>
<tr>
<td>Unlocking the modem</td>
<td>47</td>
</tr>
<tr>
<td>Powering the modem off</td>
<td>47</td>
</tr>
<tr>
<td>Warranty</td>
<td>48</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>48</td>
</tr>
<tr>
<td>Uninstalling the Watcher Lite software</td>
<td>48</td>
</tr>
</tbody>
</table>
1: Introducing the Compass 597 USB modem

Welcome

The Sierra Wireless Compass 597 USB modem is a dual-band wireless USB modem for cellular and PCS networks, and the GPS frequency band. It enhances the functionality of your mobile computing device by adding 2-way messaging and high-speed mobile data in extended areas, compared to wireless local area networks.

This modem allows you to do the following (subject to feature availability), without using a wireline phone or network:

• Connect to the Internet, VPN and corporate networks
• Send and receive large e-mail messages
• Send and receive SMS messages (Windows only)
• Use location-based services (Windows only)
• Conduct video-conferencing
• Access streaming, real-time media
• Play games online

Note: You can view this guide online or print it to keep on hand. If you're viewing it online, simply click a topic in the Table of Contents, or a page number in the Index, or any page reference or section reference. (Most text that is blue is a clickable link.) The PDF automatically displays the appropriate page.
Feature summary

The Compass USB modem is designed to provide a wide range of capabilities using CDMA network technology. Implementation of these features depends on the particular service provider and account features you have chosen.

Some features described in this manual may not be supported by your service provider or may not be available with your network account. For details of the services and accounts available, contact your service provider.

Wireless modem

Windows

Once installed and configured, the modem can connect to the CDMA network automatically. You just insert the modem, allow Watcher to autolaunch and authenticate your account on the network, then launch your Internet browser (which you can also configure in Watcher to launch automatically) — you’re online!

Alternatively, you can make a high-speed data connection without running Watcher—simply by launching whatever application you want to use (such as your web browser or e-mail application). For details, see the online help topic “Autoconnect behaviour”.

The modem also allows you to dial up a modem (such as a corporate server).

Mac

Once the modem is installed and configured, you can use it to connect to the CDMA network. You just insert the modem, start Watcher Lite and allow it to authenticate your account on the network, then launch your Internet browser — you’re online!

TRU-Install

TRU-Install™ is a Sierra Wireless feature that installs the necessary software and drivers the first time you insert the modem into your Windows or Mac computer. An installation CD is not required.
TRU-Locate

With TRU-Locate™, you can use location-based services (GPS) on your Windows computer to query, for example, the network for information on points of interest (POI) that are near your current location, or display driving instructions.

Note: TRU-Locate is available on Windows only; subject to feature availability.

Your modem requires an unobstructed view of GPS satellites (in the sky), and, like any other GPS device, might not perform well within forested areas or near tall buildings.

Depending on your account, you may be charged for each position fix or after you have performed a certain number of fixes. For details, contact your service provider.

Depending on the mechanism that the network and your modem use to obtain location information, GPS may not be supported:

- If Network Mode is set to “EVDO Only”
- If you’re roaming
- If you do not have network coverage
- Due to other reasons.

If you’re having problems using GPS, contact your service provider.

CDMA 3G services

The modem operates over a type of wireless network called CDMA (Code Division Multiple Access).

CDMA 3G technology provides a variety of connectivity features, depending on your service provider and account:

- **1x-EVDO Rev. A** supports Internet connections with data rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to the network). Average data rates are 450-800 Kbps (downlink from the network) and 300-400 Kbps (uplink to the network). Actual speed depends on the network conditions.
- **1x-EVDO Rev. 0** supports Internet connections with data rates up to 2.4 Mbps (downlink from the network) and 153 Kbps (uplink to the network). Average data rates are 400-700 Kbps (downlink from the network) and 40-80 Kbps (uplink to the network). Actual speed depends on the network conditions.
• 1X supports Internet connections with data rates up to 153 Kbps. Actual speed depends on the network conditions.

Once the connection is established, you can open your browser and connect to any website that is accessible through the Internet, or access other Internet services (such as e-mail).

The connection is “active” when data transmission is occurring. If data transmission stops for a period of time (determined by the network), the connection becomes dormant.

• Circuit switched (dial-up) data, using the earlier CDMA IS-95 specification, supports data connections to any dial-in service at rates up to 14.4 Kbps.

• QNC (Quick Net Connect) provides a simplified way to dial into an Internet connection (using circuit switched data) where 3G (1xEV-DO or 1X) high-speed packet service is not available.

• SMS (Short Message Service) allows you to send and receive short text messages using the modem (Windows only).

Additional Compass USB modem features

Beyond the features of the CDMA network, the modem provides additional software features:

• PIN security code to protect your modem and account from unauthorized use.

• A wizard to assist with activating your CDMA account.

• Sound options to customize ringtones for SMS messages (Windows only).

• A Call Log to track outgoing calls and determine the amount of data transferred (Windows only).

The modem has a microSD™ slot that can be used, with a microSD card (sold separately), for file transfer or storage. For more information, see “Using a microSD card” on page 24.
Introducing the Compass 597 USB modem

Package contents

Your package contains the following components:

- Compass 597 USB modem
- Quick Start Guide
- Carrying pouch
- Lanyard
- 7-inch USB extension cable

Note: Use only the supplied USB extension cable; other cables may not work with the modem.

To install the Compass USB modem drivers and software, you do not need an installation CD. Your modem uses the Sierra Wireless TRU-Install feature. The drivers and software are installed when you insert the modem into your computer.

System components

Your modem is just one part of a system designed to provide you with a wide range of communication features. Every component of the system is needed to enable these capabilities.

Your host computing device

Your notebook or desktop computer hosts the USB modem hardware and runs the communication software: your web browser or e-mail application, and Watcher (Windows) or Watcher Lite (Mac)—the enabling software for the modem.

You may also have other software on your computer that can be used wirelessly with the modem, such as: file transfer applications (FTP), chat or instant messaging, a VPN (Virtual Private Network) client, client software for a corporate server application.

The Compass 597 USB modem

The modem provides your computer with a connection to the CDMA wireless network.

The modem fits into a USB slot available on most notebook and desktop computers.
Every CDMA network operates on one of three radio frequency bands. As a dual-band product, the modem operates on two of these bands (see page 50), providing a wide coverage area.

The modem drivers and enabling software

The modem drivers and enabling software (Watcher [Windows] or Watcher Lite [Mac]) monitor and manage your wireless connections.

Your modem uses the Sierra Wireless TRU-Install feature—the drivers and software are installed when you insert the modem into your computer.

The device driver software enables the modem to work with your computer’s operating system.

Using the Watcher (Windows) or Watcher Lite (Mac) software, you can manage the modem and monitor your connections. For step-by-step instructions to access features of Watcher (Windows), use the application’s online help.

CDMA service provider account

Companies that operate CDMA networks and provide access to these networks are called service providers. To use the modem, you must have an account with a CDMA service provider.

Each service provider has its own pricing options. There may be flat rate accounts, which provide you a maximum number of minutes of network usage for a fixed monthly fee. There may be accounts for which you are charged for network usage by the minute or by the amount of data transmitted.

Your account may include a variety of other services such as SMS messaging or location-based services (Windows only).

Each modem has been provisioned at the factory for use with a particular service provider. This sets the modem to use particular radio channels and enables services specific for that provider.

The process of setting up your account is called activation. Activation involves action by the service provider and configuration of the modem.

The procedure to configure (activate) your modem is covered in “Activation” on page 27.

Note: You can use the Lock Modem feature to prevent others from using your account, should your modem be stolen.
The CDMA wireless network

This is the worldwide infrastructure providing the radio coverage that allows you to stay connected. Made up of radio towers and a variety of network switches, routers, and servers, the network is an interconnection of many service providers.

There are CDMA networks that operate in the frequency bands supported by the modem throughout North America and parts of Latin America, Asia, and New Zealand. However, each service provider operates a network that covers a limited geographical area within the overall CDMA coverage area.

Most service providers have “roaming” agreements with other service providers, so that they can offer service outside of the coverage area of their own networks. For example, assuming you live in Vancouver (Canada), and travel frequently to Seattle (United States), you can obtain an account with a Vancouver service provider that has a roaming agreement with a service provider in Seattle. You would then have local service in Vancouver, and roaming service in Seattle.

Care and maintenance of your modem

As with any electronic device, the modem must be handled with care to ensure reliable operation. Follow these guidelines in using and storing the modem:

- The modem should fit easily into your USB slot. Forcing the modem into a slot may damage connector pins.
- When inserting or removing the modem, always grip it by the sides rather than the end.
- Protect the modem from liquids, dust, and excessive heat.
- When not installed in your computer, store the modem in a safe place.
Before you can begin using the modem, you must:

1. Insert the modem, to install the enabling software and drivers.

2. Activate an account and configure the modem to use your account (unless the modem has been pre-activated).

This section provides an overview of this process.

The Compass 597 software

The modem comes with the following software:

- Watcher application that you use to manage the modem and monitor your connections on a Windows computer
- Watcher Lite application that you use to manage the modem and monitor your connections on a Mac computer
- The driver software that provides the interface between the modem and your Windows or Mac operating system

Detailed instructions for installing the modem and its software are provided in “Installation” on page 19.

Account activation and configuration

To use the modem, you must have an account with a CDMA service provider. The process of setting up an account is called activation.

If you purchased the modem directly from a service provider, you may already have an account; your modem may be pre-activated.

Otherwise, run the Watcher (Windows) or Watcher Lite (Mac) software and the Activation Wizard (Windows) or Activation Assistant (Mac), which guides you through the activation and configuration process. (Depending on your configuration, the software and the activation procedure may start automatically.)
Configuring the modem involves setting the phone number assigned by your service provider and may involve entering other network parameters and settings such as a user name and password to access services.

Your service provider needs to know:

- The billing information to use to collect payment for your network usage.
- The ESN (Electronic Serial Number) or MEID (Mobile Equipment Identifier) assigned to your modem during the manufacturing process. (The ESN or MEID is printed on a label on the modem and can be displayed in the software.) This number is used to help authenticate your account when you connect for service.

You require from your service provider:

- An activation code that gives you access to configure the account.
- A phone number for your modem.
- Additional information specific to your service provider such as:
  - A user ID (username) and password to authenticate your network connection.
  - A SID (System IDentifier) that identifies your home network area and is used together with your phone number to determine if you are “home” or “roaming”.


3: Installation

• System requirements
• Installation (Windows)
• Installation (Mac)
• Inserting the modem
• Removing the modem
• Using the USB extension cable
• Using a microSD card
• Using an external antenna

This chapter guides you through the steps necessary to install the modem on a notebook or desktop computer.

The basic steps are:

1. Insert the modem into the USB slot (page 22) to install the modem drivers and software.

2. If the modem has not been pre-activated, use the Activation Wizard (Windows) or Activation Assistant (Mac) to configure the modem (as described in “Activation” on page 27).

Before you begin the installation process, ensure your computer is running a supported operating system and meets the hardware requirements described below.

System requirements

The USB modem is supported on notebook and desktop computers running:

• Windows Vista
• Windows XP (Home and Professional versions) with Service Pack 2 or later
• Windows 2000 with Service Pack 4 and Update Rollup 1
• Mac OS X version 10.4 or newer

To install and use the modem, you require one USB slot.
Mac requirements

The USB modem is supported on these Mac computers running Mac OS X version 10.4 or newer:

- MacBook™
- MacBook Air™
- MacBook Pro
- PowerBook® G4
- Power Mac® G5
- desktop iMac

To check your version of Mac OS X, from the Apple menu () choose About This Mac. If your version is earlier than 10.4, then you must upgrade to version 10.4 or newer. Contact an Apple reseller, an Apple retail store, or visit www.apple.com/store.

Go to “Installing on a Mac computer” on page 22.

Installing on a Windows computer

Note: If you’re running Windows XP, you may require administrative privileges, depending on the Windows XP installation. If you’re running Windows Vista or Windows 2000, you must be logged in with administrative privileges to install the modem software. If you’re running Windows 2000, your computer might be restarted, as part of the installation process; save any open documents.

To install Watcher and the modem drivers:

1. Insert the modem into your USB slot (as described in “Inserting the modem” on page 22).
2. If you’re running Windows Vista, in the AutoPlay window click Sierra Wireless Watcher Installation. The Software Installation Wizard should start automatically.
3. In the “Welcome to the InstallShield Wizard” window, select Install to launch the InstallShield® Wizard.

Note: Do not forcefully insert the modem. This may damage the connector pins.
4. If the Open With... window appears, cancel the installation (your computer is missing some files required for the installation). Search for Instmsiw.exe (if you’re running Windows 2000) among the downloads at www.microsoft.com. Install the file on your computer, remove the modem from your computer, then rerun the installation.

5. If the Ikernel Application Error window appears:
   a) Cancel the installation.
   b) Download the file:
   c) Install the file on your computer, remove the modem from your computer, then rerun the installation.

6. Use the Next and Back buttons to navigate through the wizard noting the following:
   - To proceed with the installation, you must click **I accept the terms in the license agreement** to indicate your acceptance of the terms of the license agreement.

   Windows detects the modem and installs the drivers for it. This may take a few minutes. Once completed, the **system tray** may display the message “Your devices are ready to use” or “Your new hardware is installed and ready to use”:

   ![Found New Hardware](image)

   Your new hardware is installed and ready to use.

7. If you are prompted to restart your computer:
   a) Save any open documents.
   b) Select the option to restart your computer.
   c) Wait until your computer restarts and Windows is ready.

8. When you are notified that the installation is complete, click **Finish**.

9. If Watcher has not started automatically, start it: double-click the Watcher icon on your desktop.

10. Proceed to configure the modem to use your account (if it was not pre-activated). See “Activation” on page 27.
Installing on a Mac computer

To install Watcher Lite and the modem drivers:

1. Insert the modem into your USB slot (as described in “Inserting the modem” on page 22).
2. In the Finder™ window, double-click SierraWirelessWatcherLite.mpkg.
3. In the “Welcome to the Sierra Wireless Watcher Lite Installer” window, click Continue.
4. In the “Standard Install on ...” window, click Install.
5. If a window appears, prompting you to enter your password, enter your Mac password, and then click OK.
6. In the window with the message that you will have to restart your computer, click Continue Installation.
7. In the “Installation completed successfully” window, click Restart.
8. After your computer restarts, configure the modem to use your account (if it was not pre-activated), as described in “Activation” on page 27.

USB modem insertion and removal

Inserting the modem

To insert the modem into a computer:

1. Remove the protective cap from the USB connector of the modem.
2. Gently insert the modem into the USB slot. Alternatively, you can attach the USB extension cable (included in your package) to your computer’s USB slot, and insert the modem into the USB extension cable.

Note: If your computer’s USB slot is vertical, use the USB extension cable. Do not insert the modem into a USB hub or a USB slot on a keyboard.
Warning: If the orientation of your computer’s USB slot or the thickness of your computer are such that pressure is applied to the modem’s end or side (as shown by the red circle in the drawing below), you may damage the modem or your computer. In such cases, do not insert the modem directly into your computer’s USB slot; use the USB extension cable instead. See “Using the USB extension cable” on page 24.

When you insert the modem on a Windows computer, the following should occur:

- The modem’s power LED ( ) becomes lit.
- If sound effects are enabled, the PC beeps.
- The Safely Remove Hardware icon appears in the system tray, if it is not already displayed for another device (and unless the feature has been disabled).

![Warning icon](image)

Windows Vista  Windows XP  Windows 2000

- Watcher launches (unless the autolaunch feature has been disabled).

The modem is powered as soon as you insert it.

Removing the modem

Windows

To remove the modem:

1. Close Watcher if it is open.
2. If a microSD card is inserted into the modem, ensure you’ve completed any file transfers.
3. Click the Safely Remove Hardware icon in the system tray to display the option to stop the device.
4. Click the Safely remove USB Mass Storage Device (Windows Vista or Windows XP) or Stop USB Mass Storage Device (Windows 2000) entry for the USB modem.

5. If a dialog box appears notifying you that it is safe to remove the device, click OK.

6. If you’re running Windows 2000, click Stop Sierra Wireless Compass 597 EVDO Network Adapter.

7. Pull the modem out of the slot by gripping both sides of the modem and pulling the modem straight out.

**Mac**

To remove the modem:

1. End your network connection (in Watcher Lite, click Disconnect).
2. Close Watcher Lite if it is open.
3. If a microSD card is inserted into the modem, ensure you’ve completed any file transfers, and then eject the drive.
4. Pull the modem out of the slot by gripping both sides of the modem and pulling the modem straight out.

**Using the USB extension cable**

Optionally, you can use the provided USB extension cable. This allows you to use your modem in crowded spaces. The USB extension cable is flexible, and retains its shape.

*Note: Use only the supplied USB extension cable; other cables may not work with the USB modem.*

To connect the USB extension cable:

1. Insert one end of the USB extension cable into the USB port of your computer.
2. Insert the modem into the USB extension cable. When the modem and the cable are properly connected, the modem’s power LED (blue, or blinking amber) becomes lit.

**Using a microSD card**

Your computer recognizes the microSD card as a removable storage device.

Your modem supports microSD cards up to 32 GB capacity.
Note: Using microSD cards larger than 32 GB can cause data loss and damage your modem.

Inserting the microSD card

To insert the microSD card:

1. Gently flip open the tab (labelled “microSD”) on the side of the modem (1).
2. Hold the modem with the LEDs facing up.
3. Gently insert the microSD card (label facing up—see the above photo) into the slot on the side of the modem (2) until the microSD card clicks into place.

If your microSD card has not been formatted, or is in a format that your computer does not recognize, you may be prompted to format the microSD card.

Note: The formatting procedure erases all the data on the microSD card, after which the files CANNOT be retrieved. To prevent the loss of important data, please check the contents before you format the microSD card.

Removing the microSD card

To remove the microSD card:

1. Ensure you’ve completed any file transfers.
2. Safely remove the hardware:

   Windows Vista and Windows XP: Click the Safely Remove Hardware icon ( in Windows Vista; in Windows XP) in the system tray, and click the Safely remove USB Mass Storage Device entry for the microSD card.

   Windows 2000: Click the Safely Remove Hardware icon in the system tray, and click the Stop USB Mass Storage Device entry for the microSD card.

   Mac: Eject the drive.
3. Using your fingernail or a thin blunt object, gently press the microSD card in and then release; it should partially pop out of its slot, as shown in the photo.

4. Remove the microSD card and store it in a safe place.

5. Close the tab over the microSD card of the modem.

**Using an external antenna**

You can improve the signal strength, by attaching an external antenna (sold separately). The recommended antenna is the 5-band blade antenna with SMK connector, available from [www.sierrawireless.com](http://www.sierrawireless.com).

To attach the external antenna:

1. **Remove the USB modem** from your computer.
2. Flip open the unlabeled tab (on the side of the modem).
3. Holding the antenna cable by the connector (end) part, carefully push the connector part of the cable into the corresponding connector on the modem.
4. Carefully **insert the USB modem** into your computer’s USB slot.
Account configuration procedures

The final step to making the modem operational is configuring it to use your CDMA service provider account. The process of activation configures your modem with the required account parameters (phone number, username, password, and so on).

If you purchased a pre-activated modem, this step is not necessary. Once the application software and drivers are installed, the modem is ready for use. Proceed to “Watcher Basics (Windows)” on page 31 or “Watcher Lite Basics (Mac)” on page 41.

Otherwise, you must use the Activation Wizard (Windows; described below) or Activation Assistant (Mac; see page 28) to activate and configure your account.

Activating on a Windows computer

Activation Wizard

The Activation Wizard walks you through the process of configuring an account. The process and options vary based on the service provider.

This section is a guide only. Consult the Quick Start Guide, and follow the directions on screen and instructions given by your service provider representative.

If your modem does not have an activated account, and Watcher has started automatically, then the Activation Wizard should start automatically. If this does not happen:

1. Ensure Watcher is running. If it is not, double-click the Watcher icon on your desktop.

3. If the **Automated Activation** option is not available, select **Manual Activation** and go to “Manual activation” (below).

4. Select the **Automated Activation** option.
   
   The activation progress is displayed in the Activation Wizard window. If the process is successful, the window displays “Activation successful”.

   **Note:** If the window does not display “Activation successful”, retry the process. If the process continues to fail, use manual activation (below) or contact your service provider.

At this point your modem is ready to use.

Proceed to “Watcher Basics (Windows)” on page 31.

**Manual activation**

Manual activation involves phoning your service provider, exchanging information, and entering your account information into the appropriate fields in the wizard. (To use this method, you require a phone.)

Use the **Next** and **Back** buttons to navigate through the wizard, noting the following:

- Prepare your billing information, before you phone the service provider or proceed to the next window.
- Contact your service provider. Inform your service provider that you are activating your Sierra Wireless Compass 597 USB modem. The representative will request your ESN (Electronic Serial Number) or MEID. This is displayed in the Activation Wizard (and is printed on the Compass USB modem box and on the label on the back of the modem).
- As prompted by the wizard, enter the information provided by the service representative.
- Select **Finish** in the final window of the wizard.

On completion of the Activation Wizard, the modem is ready for use. Proceed to “Watcher Basics (Windows)” on page 31.

### Activating on a Mac computer

After your computer has restarted:

1. Run Watcher Lite: in Finder, choose Go > Applications, and then double-click **Sierra Wireless Watcher**. Watcher Lite should start.

2. If the New Port Detected window appears, click **Continue**.
3. If a window appears, prompting you to enter your password, enter your Mac password, and then click **OK**. Watcher Lite displays a status message or the “Activation Assistant” window.

4. Use the following table to determine your next actions.

**Table 4-1: Text/window displayed, and your next action**

<table>
<thead>
<tr>
<th>Text/window displayed</th>
<th>Description/next action</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Disconnected”</td>
<td>Your device is preactivated. You are ready to connect to the network. Proceed to “Watcher Lite window” on page 42.</td>
</tr>
</tbody>
</table>
| “Device is Locked”            | Your device is preactivated. Unlock the device:

1. If the Unlock Device window is not displayed: from the **Extras** item on the Sierra Wireless Watcher menu, choose **Unlock Device**.

2. In the Unlock Device window, enter the lock code (PIN), and click **OK**.

If you can’t recall your lock code, try using the last four digits of your device’s phone number or try 0000. If none of these work, contact your service provider.

Once your device is unlocked, you are ready to connect to the network. Proceed to “Watcher Lite window” on page 42. |
| “Activation Assistant” window | Your device is not activated.

1. Click **Continue** to indicate that you'd like to activate your device.

Watcher Lite will display “Activating Sierra Wireless Compass 597 EVDO Modem Device.”

Wait until the process is completed.

If provisioning is successful, Watcher Lite displays “Disconnected,” after which you are ready to connect to the network.

Proceed to “Watcher Lite window” on page 42.

2. If the Device Activation Failed! window is displayed, use the Activation Assistant (see page 30). |
| “Not activated”               | Your device is not activated. Use the Activation Assistant (see page 30).                                                                                 |
Activation Assistant

If your device is not activated, use the Activation Assistant:

1. From the **Extras** item on the Sierra Wireless Watcher menu, choose **Activation**.
2. In the Activation Assistant window, click **Continue**.
3. Ensure you have the items listed on the screen, and phone your service provider. Inform them that you are activating a Sierra Wireless wireless device.
4. Follow the instructions of your service provider to activate your device. Write down this information that your service provider gives you (depending on your service provider, some of the following items may not apply):
   - Activation code (MSL): ______________
   - Compass 597 phone number (MDN): ______________
   - MIN / IMSI_S (if not the same value as your MDN [above]): __________________________
   - MSID: __________________________________________

After your service provider sets up your account on the network, your device is activated.

5. To complete the activation process, enter the information (that you wrote down) into the fields on the screen, and go through the rest of the Activation Assistant.
6. If a window appears, prompting you to enter your password, enter your Mac password, then click **OK**.
7. If the New Port Configuration window appears, click **Continue** to automatically configure your computer to use your device.
8. Proceed to “Watcher Lite window” on page 42.
5: Watcher Basics (Windows)

- Starting and closing Watcher
- Components of the Watcher Window
- Interpreting icons
- GPS Monitor window
- Online Help
- Warranty
- Troubleshooting

Watcher is the Windows application that allows you to manage and monitor the connection between the modem and the CDMA network. You use Watcher to:

- Determine your signal strength, roaming status, 3G high-speed data availability, and other network connection parameters
- Initiate and end data calls
- Use location-based services (subject to feature availability)
- View call statistics
- Receive and send SMS messages
- Customize features and options

Depending on Watcher settings, you may be able to connect to the CDMA network without starting Watcher—simply by launching whatever application you want to use (such as your web browser or e-mail application). However, Watcher and its icon in the system tray won’t be available for you to monitor the status of the connection. Location-based services also won’t be available.

Starting and closing Watcher

Depending on your settings in the Options window, Watcher may launch automatically anytime you insert the modem. You can also launch Watcher by:

- Double-clicking the Watcher icon on your desktop
- Selecting:
  - In Windows Vista or Windows XP: Start > All Programs > Sierra Wireless > Watcher > Watcher
  - In Windows 2000: Start > Programs > Sierra Wireless > Watcher > Watcher
The standard Windows control buttons in the upper right corner of the window are used to minimize or close Watcher. When minimized, Watcher does not appear as a taskbar button. Instead, an icon is shown in the system tray, usually at the right end of the taskbar. (See “Minimized icons” on page 36.)

**Components of the Watcher window**

The window has three areas that display messages and icons: the Connection Status Area (page 34), Call Status Area (page 35), and Indicator Area (page 36). These areas are shown in Figure 5-1 that follows.

A menu bar is located on the upper left side of the window. Windows control buttons are in the top right corner.

For a detailed description of each option in the menus, see the online help.
Window controls

- The Minimize button closes the Watcher window but leaves the application running. When Watcher is minimized, you can use the Watcher icon in the system tray to determine the modem status. (See “Minimized icons” on page 36.) This icon replaces a taskbar button for Watcher.
  Once minimized, you can redisplay the Watcher window by doing one of the following:
  - Clicking the Watcher icon in the system tray.
  - Double-clicking the Watcher desktop shortcut
  - Launching Watcher from the Start menu.
- The Toggle Full/Compact button is used to switch between the full Watcher window and the compact view:

  ![Watcher Window Controls](image)

  The compact view allows you to see connection status and indicators while using less space on the desktop. If you right-click the compact view, a menu is displayed. From this menu you can open some of the other Watcher windows or establish/end a data connection.

  To return to full view, click the view toggle button in the top right.
- The Close button is used to exit Watcher.

Docking

You can set the Watcher window to “jump” to the edge of your screen when you move the window close to an edge. This lets you easily position Watcher in a corner of the screen.

- Select View > Docking

Always On Top

You can set Watcher to always display in front of other windows. This allows you to monitor connection status while using another maximized application, such as your web browser.

- Select View > Always On Top
Interpreting icons

Watcher makes extensive use of icons to indicate status and events. The various icons are described in the following sections on the display areas of Watcher.

Connection Status Area

The Connection Status Area uses the icons shown in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| ![Modem not detected icon](image) | Modem not detected.  
You may be able to resolve this by doing one of the following:  
- Unlocking the modem (Tools > Unlock Modem)  
- Powering the modem on (Tools > Turn Radio On)  
- Ejecting the modem and re-inserting it  
If this icon is still displayed, restart your computer. |
| ![Signal Strength icon](image) | The Signal Strength indicator uses bars to show the intensity of the radio signal. The number of bars increases as signal strength increases, to a maximum of five bars.  
When the bars are dimmed and the antenna icon is crossed out, no connection is possible for one of these reasons:  
- You are outside the CDMA network coverage area  
- The signal strength is too weak  
- A network or account problem is preventing the modem from obtaining service |
| ![1xEV-DO Rev. A icon](image) | 1xEV-DO Rev. A icon. |
| ![1xEV-DO Rev. 0 icon](image) | 1xEV-DO Rev. 0 icon. |
| ![1X icon](image) | 1X icon. |
| ![Ev0 icon](image) | When only the letters are displayed, you have acquired service, but have not established a data connection. |
| ![Ev0 icon with gray background](image) | When the indicator has a gray background, the network connection is dormant. (You are connected, but there is currently no traffic.) |
| ![Ev0 icon with darker background](image) | When the indicator has a darker background, you have a data connection on the wireless service. |
Table 5-1: Connection Status Area icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>The Roaming Status indicator shows whether you are roaming onto the network of a service provider other than your own. When the indicator is off (gray), you are within the local coverage area of your service provider. When the indicator is on (solid black), you are roaming. Your coverage area and account charges depend upon your service provider and the type of account you have. There may be surcharges for roaming service. If there is no roaming agreement between your service provider and the local carrier, you may be unable to establish data connections and use other features. Location-based services may not be available (depending on the settings of your device, the mechanism that the network and your device use to obtain location information, and other factors).</td>
</tr>
</tbody>
</table>

**Call Status Area**

The Call Status Area displays messages related to the status or progress of a connection.

Where a duration timer is shown, timing begins when the call is initiated—not from the time the call is fully connected. This is a measure of the time the modem has been using the radio channel (a wireless network resource).

“Click this display to exit PowerSave mode” indicates that the modem could not find a system within a 15 minute interval. To conserve power, the modem reduces channel scanning to once every three minutes. To force the modem out of PowerSave mode, click in the Call Status Area. The modem performs a channel scan and, if no network is detected, returns to PowerSave mode.
Indicator area

The Indicator area displays an icon that notifies you when you receive SMS messages, and an icon that reflects the GPS status (subject to feature availability; network operator dependent).

Table 5-2: Indicator Area icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📩</td>
<td>The SMS message indicator shows whether you have unread messages. A blinking icon indicates that there are one or more urgent or important unread messages. To display the SMS Express window (in which the messages are displayed) select <strong>Tools &gt; SMS Express</strong>, or double-click the icon.</td>
</tr>
<tr>
<td>🌍</td>
<td>If you position the mouse pointer over the GPS icon, the ToolTip shows the GPS status (on or off). Double-click the icon to open the GPS Monitor window (page 37). (Network operator dependent; this icon may not be displayed.)</td>
</tr>
</tbody>
</table>

Minimized icons

Watcher displays an icon in the Windows system tray (which is usually located in the lower right corner of your screen). The system tray icon indicates your connection status or notifies you when you have SMS messages.

Table 5-3: System tray icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌍</td>
<td>Watcher cannot detect the modem. Ensure that the modem is powered on, not locked, and properly connected to your computer.</td>
</tr>
<tr>
<td>🌈</td>
<td>You are in service on the network but have no active data connection. The number of red bars indicates the signal strength.</td>
</tr>
<tr>
<td>🌈</td>
<td>You have an active data connection. The number of green bars indicates the signal strength.</td>
</tr>
<tr>
<td>📩</td>
<td>You have a new SMS message.</td>
</tr>
</tbody>
</table>
Only one icon can be displayed at a time. The priority of icons, from highest to lowest, is:

- No modem detected
- SMS message(s)
- Active or inactive connection.

For example, if you have unread SMS messages, and then establish a data connection, the icon still displays as an unread SMS message.

**GPS Monitor window**

The GPS Monitor window reports GPS data from your modem.

The modem must have a fix on at least four satellites to report latitude, longitude, altitude, velocity and heading. (The status bar at the bottom of the GPS Monitor window indicates how many satellites are being tracked.)

To open the GPS Monitor window:

1. In Watcher, select **Tools > Display GPS**.
   - or -
   Double-click the GPS icon in the main Watcher window (network operator dependent; this icon may not be available).

The GPS Monitor window reports:

- Longitude and Latitude — your coordinates in degrees, minutes, and seconds.
- Direction — your direction in degrees from true north (0), increasing clockwise.
- Speed — calculated based on your current latitude and longitude and the last reading (one second previous). This is either in kilometers per hour or miles per hour, depending on your chosen option.
- Altitude — your altitude relative to mean sea level, in either feet or meters, depending on your chosen option.
- GPS port — port used for GPS activity.
- Updated — date/time that the GPS values were last acquired. The display format is based on your Control Panel settings in Windows.

From the GPS Monitor window you can:
- Determine the number of satellites being tracked
- Get your current location
- View a map of your current location
- Start/stop a tracking session
- Configure GPS settings

For detailed information on using GPS and configuring the settings, see the online Help of GPS Monitor.

**Online Help**

The Watcher and GPS Monitor applications include extensive online help to provide operating hints and step-by-step instructions for getting the most from your modem.

You can access online help in several ways:
- Press <F1> in any window.
- Use Windows Explorer to navigate to Program Files > Sierra Wireless Inc > Watcher > Help, and double-click Watcher_ENU.chm (for Watcher help) or GPS_ENU.chm (for GPS Monitor help).

The help files have a table of contents, an index, and search capabilities.

**Warranty**

You can access a PDF of the warranty, in:
- Windows Vista or Windows XP: Start > All Programs > Sierra Wireless > Watcher
- Windows 2000: Start > Programs > Sierra Wireless > Watcher
Troubleshooting

The online help includes descriptions of most common error messages. Look in the table of contents under Troubleshooting.

For help with other problems:

- Consult the Sierra Wireless web site at www.sierrawireless.com, where you will find an extensive knowledge base that can be searched to address most problems.
- Contact your service provider.
6: Watcher Lite Basics (Mac)

- Starting and closing Watcher Lite
- Watcher Lite window
- Watcher Lite menu options
- Connecting to the network
- Displaying your phone number and ESN
- Security
- Powering the modem off
- Warranty
- Troubleshooting
- Uninstalling the Watcher Lite software

Watcher Lite is the Mac application that allows you to manage and monitor the connection between the modem and the CDMA network. You use Watcher Lite to:

- Determine your signal strength, roaming status, 3G high-speed data availability, and other network connection parameters
- Initiate and end data calls
- View call statistics

Starting and closing Watcher Lite

To start Watcher Lite:
1. Ensure the modem is inserted into your computer’s USB slot.
2. In Finder, choose Go > Applications > Sierra Wireless Watcher.

To close Watcher Lite:
1. Click the button in the upper left corner of the Watcher Lite window.
Watcher Lite window

The window has two areas that display messages and icons: the Message Area, and Indicator Area. These areas are shown in Figure 6-1 that follows.

Figure 6-1: Watcher Lite window

The Watcher Lite window may display, depending on the coverage and connection state, some of the following icons and text:

Table 6-1: Watcher Lite icons and text

<table>
<thead>
<tr>
<th>Icon/text</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="CDMA signal strength icon" /></td>
<td>CDMA network signal strength, indicated by the number of bars.</td>
</tr>
<tr>
<td><img src="image" alt="1X coverage icon" /></td>
<td>You are outside the CDMA network coverage area.</td>
</tr>
<tr>
<td><img src="image" alt="1xEV-DO Rev. 0 coverage icon" /></td>
<td>You have 1X and 1xEV-DO Rev. 0 coverage.</td>
</tr>
<tr>
<td><img src="image" alt="1X and 1xEV-DO Rev. A coverage icon" /></td>
<td>You have 1X and 1xEV-DO Rev. A coverage.</td>
</tr>
<tr>
<td><img src="image" alt="1X coverage icon" /></td>
<td>You have 1X coverage.</td>
</tr>
<tr>
<td><img src="image" alt="1xEV-DO Rev. 0 coverage icon" /></td>
<td>You have 1xEV-DO Rev. 0 coverage.</td>
</tr>
<tr>
<td><img src="image" alt="1xEV-DO Rev. A coverage icon" /></td>
<td>You have 1xEV-DO Rev. A coverage.</td>
</tr>
<tr>
<td><img src="image" alt="Roaming icon" /></td>
<td>You are roaming. Your coverage area and account charges depend upon your service provider and the type of account you have. There may be surcharges for roaming service. If there is no roaming agreement between your service provider and the local carrier, you may be unable to establish data connections and use other features.</td>
</tr>
<tr>
<td><img src="image" alt="Local coverage icon" /></td>
<td>You are within the local coverage area of your service provider (not roaming).</td>
</tr>
</tbody>
</table>
Connection states

The Watcher Lite window can display various connection and interaction states, including:

- No device detected
- Not activated
- Updating User Profile
- Disconnected
- Connecting
- Connected
- Device is Locked

No device detected

Watcher Lite did not detect the modem. The Connect button is unavailable.

1. Insert the modem. If it is already inserted, remove and reinsert it; wait a few moments.
2. If this message is still displayed, uninstall (page 48) and reinstall Watcher Lite.

Not activated

To use your modem, you must activate it. Use the Activation Assistant (page 30).

Updating User Profile

Watcher Lite is performing account setup for you by making a connection to the CDMA network and using a secure Internet connection to download account parameters to your modem.

Disconnected

Watcher Lite is ready to make a connection to the network. The Connect button is available; the signal strength icon ( miệng), coverage indicator (Trinity), and the roaming icon (Trinity) are visible.

To connect to the network, click the Connect button.

Connecting

Watcher Lite is establishing a connection to the network.
**Connected**

The connection is established. In addition to the signal strength icon (📊), coverage indicator (🗺️), and roaming icon (🛢️), the amount of time you’ve been connected and the amount of data received (Rx) and transmitted (Tx) are also displayed. (See the note on page 45.)

To end the connection, click **Disconnect**.

**Device is Locked**

The modem is locked, so that others cannot use the modem and your account. To use most of the features, you must unlock the modem (page 47).

**Determining the type of coverage**

An icon in Watcher Lite (EVDO) indicates the type of coverage you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO). See the table on page 42.

**Watcher Lite menu options**

The following table describes the menu options available from the **Extras** item on the Sierra Wireless Watcher menu.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn ... Device Off</td>
<td>Power off your modem. See &quot;Powering the modem off&quot; on page 47.</td>
</tr>
<tr>
<td>Activation</td>
<td>Activate your modem. See &quot;Activation Assistant&quot; on page 30.</td>
</tr>
<tr>
<td>Data Provisioning</td>
<td>Provision your modem.</td>
</tr>
<tr>
<td>Lock Device / Unlock Device</td>
<td>Lock your modem so that others cannot use it to access your account; unlock your modem so that you can use it. See &quot;Locking the modem&quot; on page 46, or &quot;Unlocking the modem&quot; on page 47.</td>
</tr>
<tr>
<td>About ... Device</td>
<td>View information about the modem. See &quot;Displaying your phone number and ESN&quot; on page 45.</td>
</tr>
<tr>
<td>Open Internet Connect</td>
<td>View, configure, and use the data and VPN connections available on your computer (for example, WWAN).</td>
</tr>
</tbody>
</table>
Connecting to the network

To connect to the network:

1. In the Watcher Lite window, click Connect.

Once you’re connected to the network, Watcher Lite displays “Connected,” the amount of time you’ve been connected, and the amount of data received (Rx) and transmitted (Tx).

*Note: In some cases, the Connect button can establish a connection to the network, even if the button seems unavailable. If nothing seems to happen when you click the button, ensure that the modem is properly inserted, and not locked.*

Viewing the amount of data transferred

Once you’re connected to the network, Watcher Lite shows the amount of data received (Rx) and transmitted (Tx).

*Note: The information is not intended for billing purposes.*

Once you end the connection, all numbers reset to zero.

Ending a connection

To end your network connection:

1. In the Watcher Lite window, click Disconnect.

Displaying your phone number and ESN

You can view your phone number (“Directory Number”) and ESN in the “About ... Device” window.

To display the “About ... Device” window:

1. From the Extras item on the Sierra Wireless Watcher menu, select About ... Device.

Security

When it is disconnected, you can lock your modem so that others cannot use the modem and your account. A four-digit lock code is needed to unlock the modem.
**Initial lock code**

The initial lock code value is determined by your service provider.

For service provider configurations that do not require account activation, a default lock code is set at the factory to a value determined by the service provider. For assistance, contact your service provider.

Configurations that use the Activation Assistant or automated activation set the initial lock code to the last four digits of your account phone number whenever a new phone number is activated.

*Note: The security lock code is reset to the last four digits of the phone number whenever an account is activated.*

**Warning regarding the lock code**

If you lock the modem and forget the lock code, you will not be able to use the modem until you receive assistance from your service provider.

**When the modem is locked**

When the modem is locked, you can:

- Unlock the modem (page 47).
- Power off the modem (page 47).

When the modem is locked, you cannot:

- Make data connections (the **Connect** button is unavailable).
- Run the Activation Assistant.

**Locking the modem**

*Note: If you forget the lock code, you will not be able to use the modem until you receive assistance from your service provider.*

To lock the modem:

1. End any active connection. (You can lock the modem only when it is disconnected; page 43.)
2. From the **Extras** item on the Sierra Wireless Watcher menu, choose **Lock Device**.
3. In the “Lock Device” window, enter the lock code (PIN), and click **OK**.
When the modem is locked, Watcher Lite displays “Device is Locked.” The Connect button is unavailable.

Unlocking the modem

When the modem is locked, Watcher Lite displays “Device is Locked.”

To unlock the modem:

1. If the “Unlock Device” window is not displayed: from the Extras item on the Sierra Wireless Watcher menu, choose Unlock Device.
2. In the “Unlock Device” window, enter the lock code (PIN), and click OK.
   If you can’t recall your lock code, try using the last four digits of your modem’s phone number. If this doesn’t work, call your service provider.

When the modem is unlocked, Watcher Lite no longer displays “Device is Locked.”

Powering the modem off

If you are using your modem in an aircraft, hospital, or other environment where the modem may cause interference, you can power the modem off (without removing it from your USB slot), and still use other functions of your computer.

This also allows you to conserve your notebook computer’s battery.

To power the modem off:

1. Close any active data connection (in Watcher Lite, click Disconnect).
2. From the Extras item on the Sierra Wireless Watcher menu, select Turn Device Off.

When the modem is powered off, Watcher Lite displays “No device detected.”

To power the modem on:

1. Remove the modem (page 23) and reinsert it.
Warranty

The Sierra Wireless warranty is installed as a PDF file on your Mac desktop.

Troubleshooting

- Consult the Sierra Wireless web site at www.sierrawireless.com, where you will find an extensive knowledge base that can be searched to address most problems.
- Contact your service provider.

Uninstalling the Watcher Lite software

Note: As part of the software removal process you will be prompted to restart your computer; save any open documents.

To remove the Watcher Lite software from your computer:

1. Exit Watcher Lite (page 41).
2. Remove the modem. (See “Removing the modem” on page 23.)
3. On your Mac desktop, double-click SierraUninstaller.
4. Click Proceed.
5. If a window appears, prompting you to enter your password, enter your Mac password, and then click OK.
6. Click Restart Now.
This chapter describes the function of the LEDs, and provides technical product data for the USB modem.

### LED operation

The modem has two LED lights. The LEDs operate as follows:

#### Table 7-1: LED operation

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>The modem has no power. You have powered off the modem, or the modem is not completely inserted into the USB slot, or the computer is in suspend mode (Windows) or sleep mode (Mac), which powers down the modem.</td>
</tr>
<tr>
<td></td>
<td>Blue, not blinking</td>
<td>The modem has power and is working properly.</td>
</tr>
<tr>
<td></td>
<td>Blue, blinking</td>
<td>The modem’s firmware is being updated. Do not remove the modem.</td>
</tr>
<tr>
<td></td>
<td>Amber, blinking</td>
<td>The modem is searching for service. If this LED state persists:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure the modem is properly connected to your computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are inside a building or near a structure that may be blocking the signal, change the position or location of your computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You may be able to improve the signal strength, by attaching an external antenna (page 26).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure you are within the CDMA network coverage area. For coverage information, contact your service provider.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check with your service provider—a network or account problem may be preventing the wireless device from obtaining service.</td>
</tr>
<tr>
<td></td>
<td>Amber, not blinking</td>
<td>An error has occurred. Remove the modem (page 23) and reinset it.</td>
</tr>
</tbody>
</table>
Table 7-1: LED operation

<table>
<thead>
<tr>
<th>LED</th>
<th>State</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>No service is available. See the suggestions for “Amber, blinking” on page 49.</td>
</tr>
<tr>
<td></td>
<td>Amber, blinking</td>
<td>1x coverage is detected. Ready to connect to the network (click Connect).</td>
</tr>
<tr>
<td></td>
<td>Amber, not blinking</td>
<td>The modem is connected to the 1X network, and can send or receive data.</td>
</tr>
<tr>
<td></td>
<td>Blue, blinking</td>
<td>1x-EVDO coverage (Rev. 0 or Rev. A) is detected. Ready to connect to the network (click Connect).</td>
</tr>
<tr>
<td></td>
<td>Blue, not blinking</td>
<td>The modem is connected to the 1x-EVDO network, and can send or receive data.</td>
</tr>
</tbody>
</table>

Radio frequency and electrical specifications

Table 7-2: Radio frequency and electrical specifications

<table>
<thead>
<tr>
<th>Approvals</th>
<th>Compliant with: IS-2000 Release 1.0 (CDMA 1X) IS-707-A Data, IS-856 (CDMA 1x-EVDO), IS-866, IS-878, IS-890, CDMA Development Group FCC (ID: N7NC597) Industry Canada (ID: 2417C-C597)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>+5.0 Vdc from USB slot</td>
</tr>
<tr>
<td>Current</td>
<td>Maximum: 550 mA (from USB port) Typical data call current (talk mode): 330 mA (1X) 410 mA (1xEV-DO) Standby: 60 mA (1xEV-DO/IS2000 hybrid mode)</td>
</tr>
<tr>
<td>Transmitter power</td>
<td>250 mW (+24 dBm) average</td>
</tr>
<tr>
<td>Transmit</td>
<td>PCS: 1850 to 1909.95 MHz Cellular: 824.04 to 848.97 MHz</td>
</tr>
<tr>
<td>Receive</td>
<td>PCS: 1930 to 1989.95 MHz Cellular: 869.04 to 893.97 MHz GPS: 1575.42 MHz</td>
</tr>
<tr>
<td>Channel spacing</td>
<td>1.25 MHz</td>
</tr>
</tbody>
</table>
### Environmental specifications

**Table 7-3: Environmental specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>-20 to +55°C</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-40 to +85°C</td>
</tr>
<tr>
<td>Humidity</td>
<td>95%, non-condensing</td>
</tr>
<tr>
<td>Vibration</td>
<td>Random vibration, 10 to 1000 Hz, nominal 6G RMS in each of 3 mutually perpendicular axes. Test duration of 60 minutes for each axis, for a total test time of 3 hours (non-operating)</td>
</tr>
<tr>
<td>Drop</td>
<td>1 m on concrete on each of 6 faces, 2 times</td>
</tr>
</tbody>
</table>
8: Regulatory Information

Important safety/compliance information

The design of the Compass 597 USB modem complies with U.S. Federal Communications Commission (FCC) and Industry Canada (IC) guidelines respecting safety levels of radio frequency (RF) exposure for portable devices, which in turn are consistent with the following safety standards previously set by Canadian, U.S. and international standards bodies:

- International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, Guidelines for limiting exposure to time-varying electric, magnetic, and electromagnetic fields (up to 300 GHz)

**FCC ID:** N7NC597

**CAUTION:** The Compass 597 USB modem has been tested for compliance with FCC / IC RF exposure limits in the laptop computer(s) configurations with a horizontal USB slot and can be used in laptop computers with substantially similar physical dimensions, construction, and electrical and RF characteristics. This USB modem must not be co-located or operated in conjunction with any other antenna or transmitter. Use of this device in any other configuration may exceed the FCC RF Exposure compliance limit. **Note:** If this USB modem is intended for use in any other portable device, you are responsible for separate approval to satisfy the SAR requirements of Part 2.1093 of FCC rules.

**NOTE:** If your computer’s USB slot is vertical, use the USB extension cable. Do not insert the modem into a USB hub or a USB slot on a keyboard.
WARNING: If the orientation of your computer’s USB slot or the thickness of your computer are such that pressure is applied to the modem’s end or side, you may damage the modem or your computer. In such cases, do not insert the modem directly into your computer’s USB slot; use the USB extension cable instead.

WARNING (EMI) - United States FCC Information - This equipment has been tested and found to comply with the limits for a Class B computing device peripheral, pursuant to Part 15, 22, and 24 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the condition that this device does not cause harmful interference.

CAUTION: Any changes or modifications not expressly approved by Sierra Wireless could void the user’s authority to operate the equipment.

WARNING (EMI) - Canada - This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference causing equipment standard entitled "Digital Apparatus", ICES-003 of the Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme sur le matériel brouilleur: "Appareils Numériques", NMB-003 édictée par le ministre des Communications.
If you have purchased this product under a United States Government contract, it shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) Section 52.227-19 for civilian agency contracts or any successor regulations. If further government regulations apply, it is your responsibility to ensure compliance with such regulations.
## Appendix A: Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1X</strong></td>
<td>One Times Radio Transmission Technology (the &quot;one times&quot; refers to the frequency spectrum). Supports Internet connections with data rates up to 153 Kbps. Actual speed depends on the network conditions. Compare to 1x-EVDO.</td>
</tr>
<tr>
<td><strong>1x-EVDO</strong></td>
<td>A high-speed standard for cellular packet data communications.</td>
</tr>
<tr>
<td></td>
<td>Rev. A supports Internet connections with data rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to the network).</td>
</tr>
<tr>
<td></td>
<td>Rev. 0 supports Internet connections with data rates up to 2.4 Mbps (downlink from the network) and 153 Kbps (uplink to the network).</td>
</tr>
<tr>
<td></td>
<td>Average data rates are: for Rev. A: 450–800 Kbps (downlink from the network) and 300–400 Kbps (uplink to the network); for Rev. 0: 400-700 Kbps (downlink from the network) and 40-80 Kbps (uplink to the network).</td>
</tr>
<tr>
<td></td>
<td>Actual speed depends on the network conditions. Compare to 1X.</td>
</tr>
<tr>
<td><strong>bps</strong></td>
<td>bits per second — The actual data speed over the transmission medium.</td>
</tr>
<tr>
<td><strong>CDMA</strong></td>
<td>Code Division Multiple Access — A wideband spread spectrum technique used in digital cellular, personal communications services, and other wireless networks. Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, thus allowing many active users to share the same channel. Each user is assigned a unique digital code, which differentiates the individual conversations on the same channel.</td>
</tr>
<tr>
<td><strong>CDMA 1X</strong></td>
<td>Also known as 1X, this is a high-speed standard for CDMA cellular communications.</td>
</tr>
<tr>
<td><strong>dormant</strong></td>
<td>The packet data connection has the logical PPP session left open while the underlying physical link (the radio channel) is released. When traffic is to resume, a radio channel is re-acquired and the original PPP session resumes.</td>
</tr>
<tr>
<td><strong>ESN</strong></td>
<td>Electronic Serial Number — The unique first-generation serial number assigned to the modem for cellular network use. Compare to MEID.</td>
</tr>
<tr>
<td><strong>ExpressCard™</strong></td>
<td>Add-in memory and communications cards for portable computers. ExpressCard is a trademark of the PCMCIA.</td>
</tr>
<tr>
<td><strong>FCC</strong></td>
<td>Federal Communications Commission—The U.S. federal agency that is responsible for interstate and foreign communications. The FCC regulates commercial and private radio spectrum management, sets rates for communications services, determines standards for equipment, and controls broadcast licensing. Consult <a href="http://www.fcc.gov">www.fcc.gov</a>.</td>
</tr>
<tr>
<td><strong>GPS</strong></td>
<td>Global Positioning System—A system that uses a series of 24 geosynchronous satellites to provide navigational data.</td>
</tr>
<tr>
<td><strong>firmware</strong></td>
<td>Software stored in ROM or EEPROM; essential programs that remain even when the system is turned off. Firmware is easier to change than hardware but more permanent than software stored on disk.</td>
</tr>
</tbody>
</table>
| **host** | • A computer that uses a modem or a similar device to answer a calling computer.  
• A source or destination in the communication network.  
• A computer that contains data or files to be accessed by client computers. Also known as a server. |
| **IS** | Interim Standard—After receiving industry consensus, the TIA forwards the standard to ANSI for approval. |
| **IS-95** | The standard for CDMA. |
| **Kbps** | Kilobits per second—Actually 1000, not 1024, as used in computer memory size measurements of kilobytes. |
| **LAN** | Local Area Network |
| **LED** | Light Emitting Diode—A semiconductor diode that emits visible or infrared light. |
| **MEID** | Mobile Equipment Identifier—The unique second-generation serial number assigned to the modem for cellular network use. Compare to ESN. |
| **MHz** | Mega-Hertz—One million cycles per second. |
| **Mbps** | Megabits per second |
| **packet** | A short fixed-length block of data, including a header, that is transmitted as a unit in a communications network. |
| **PC Card™** | Add-in memory and communications cards for portable computers. PC Card is a trademark of the PCMCIA. |
| **PCMCIA** | Personal Computer Memory Card International Association—The organization that standardizes ExpressCards and PC Cards. |
| **PCS** | Personal Communications Services—A cellular communication infrastructure that uses a different frequency range than AMPS. |
| **roaming** | A cellular subscriber is in an area where service is obtained from a cellular service provider that is not the subscriber’s provider. |
| **SMS** | Short message services—A feature that allows users of a wireless device on a wireless network to receive or transmit short electronic alphanumeric messages (up to 160 characters, depending on the service provider). |
| **system tray** | Usually located in the lower right corner of your screen |
| **TIA** | Telecommunications Industry Association—A standards-setting trade organization, whose members provide communications and information technology products, systems, distribution services and professional services in the United States and around the world. Consult [www.tiaonline.org](http://www.tiaonline.org). |
| **VPN** | Virtual Private Network |
Index

Numerics

1X
  description, 12
  icon, Mac, 42
  icon, Windows, 34
  LED - coverage is detected, 50

1x-EVDO
  description, 11
  icon (Mac), 42
  icon (Windows), 34
  LED - coverage is detected, 50

3G
  description, 11

A

About ... Device (Mac), 44
account
  activation, 17
  configuration, 27
activation
  overview, 17
  Activation Assistant (Mac), 30
  Activation Wizard (Windows), 27
  automated (Windows), 28
  Mac, 28
  manual (Windows), 28
Activation Assistant (Mac), 30
Activation Wizard (Windows), 27
altitude, 37
always on top (Windows), 33
amount of data transferred (Mac), 45
antenna, external, 26
approvals, 50
automated activation (Windows), 28

B

bands, frequency, 14

C

cable, USB extension, 24
call status area (Windows), 35
care and maintenance, 15
CDMA 1X
  description, 12
  icon, Mac, 42
  icon, Windows, 34
  LED - coverage is detected, 50

CDMA 1x-EVDO
  description, 11
  icon (Mac), 42
  icon (Windows), 34
  LED - coverage is detected, 50

CDMA network
  3G services, 11
  frequency bands, 14
  service providers, 14

circuit switched data (CSD)
  description, 12
close button
  Mac, 42
  Windows, 33
compact view (Windows), 33
connect to the network (Mac), 45
“Connected” (Mac), 44
“Connecting” (Mac), 43
connection states (Mac), 43
connection status
  Mac, 43
  Windows (indicator in system tray), 36
connection status area (Windows), 34
connection, end (Mac), 45
contact information, 4
coverage
  description, 15
CSD (circuit switched data)
  description, 12
current location
  get, 38
  map of, 38

d

data
circuit switched - description, 12
dial-up - description, 12
high-speed, 11
QNC, 12
Data Provisioning (Mac), 44
data transferred, amount of (Mac), 45
“Device is Locked” (Mac), 44
dial-up data
  description, 12
direction, 37
“Disconnected” (Mac), 43
docking (Windows), 33
dormant (Windows), 34
drivers
  description, 14
driving instructions, 11
drop test, 51
E

electrical specifications, 50
Electronic Serial Number (ESN)
description, 18
view (Mac), 45
EMI warning, 54
environmental specifications, 51
ESN (Electronic Serial Number)
description, 18
view (Mac), 45
EVDO
description, 11
icon (Mac), 42
icon (Windows), 34
LED - coverage is detected, 50
extension cable, 24
external antenna, 26

F

FCC
compliance, 54
ID, 53
firmware upgrades, 4
frequency bands, CDMA network, 14
full view
description, 32
full view (Windows)
toggle button, 33

G

GPS (location-based services)
description, 11
GPS Monitor window, 37
icon, 36
port number, GPS, 38
GPS Monitor window, 37

H

hardware
inserting, 22
removing, 23
hazards, 2
help (Windows), 38
HEPE (Horizontal Estimated Position Error), 37
high-speed packet data, 11
Horizontal Estimated Position Error (HEPE), 37
humidity, 51

I

icons
connection status (Windows), 34
coverage (Mac), 42
coverage (Windows), 34
GPS (Windows only), 36
indicator area (Mac), 42
indicator area (Windows), 36
minimized (Windows), 36
roaming (Mac), 42
roaming (Windows), 35
SMS messages (Windows only), 36
system tray (Windows), 36
See also indicators.
ID, FCC, 53
indicator area (Mac), 42
indicator area (Windows), 36
indicators
connection status (Windows), 36
GPS (Windows only), 36
LED lights, 49
roaming (Mac), 42
roaming (Windows), 35
SMS messages (Windows only), 36
See also icons.
initial lock code (Mac), 46
installation, 19
interference, 54
Internet, 12

K

knowledge base, 39, 48

L

lanyard, 13
latitude, 37
LBS (location-based services)
description, 11
GPS Monitor window, 37
icon, 36
LED lights, 49
liability, limitation of, 3
limitation of liability, 3
location information (GPS), 37
location, current
get, 38
map of, 38
location-based services
description, 11
GPS Monitor window, 37
icon, 36
lock modem (Mac), 46
longitude, 37
M

Mac
  activation of modem/account, 28
  software (Watcher Lite), 41
  system requirements, 20
Mac OS X, 19
Mac software (Watcher Lite)
  overview, 41
  areas in the window, 42
  connection states, 43
  indicators, 42
  installing, 22
  menu options, 44
  starting, 41
  text, 42
  uninstalling, 48
map of your current location, 38
MEID (Mobile Equipment Identifier), 18
memory card (microSD card), 24
menu options, Mac, 44
message area (Mac), 42
microSD card
  inserting, 25
  removing, 25
minimize button
  Mac, 42
  Windows, 33
minimized icons (Windows), 36
Mobile Equipment Identifier (MEID), 18

N

“No device detected” (Mac), 43
no service, 50
“Not activated” (Mac), 43
notices, regulatory, 53
number of satellites being tracked, 38

O

online Help (Windows), 38
Open Internet Connect (Mac), 44
operating hints (Windows), 38
operating systems supported, 19
operating temperature, 51

P

packet data, high-speed, 11
phone number, view (Mac), 45
POI (points of interest), 11
points of interest (POI), 11
port, GPS, 38
power the USB modem off (Mac), 47
PowerSave mode (Windows), 35
pre-activation, 17

Q

QNC, 12
Quick Net Connect (QNC), 12

R

radio frequency specifications, 50
regulatory information, 53
requirements, system, 19
  Mac, 20
roaming
  definition, 15
  indicator (Mac), 42
  indicator (Windows), 35

S

safety, 2
sales desk, 4
satellites being tracked, number of, 38
searching for service, 49
security (Mac)
  overview, 45
  initial lock code, 46
  lock modem, 46
  unlock modem, 47
service indicator (Windows), 36
signal strength, CDMA network
  Mac, 42
  Windows, 34
SMS message indicator (Windows only), 36
software
  overview, 14
  Mac, using, 41
  Windows, using, 31
specifications
  electrical, 50
  environmental, 51
  radio frequency, 50
speed, 37
status area (Windows)
  call status area, 35
  connection status area, 34
  indicator area (Windows), 36
  Windows system tray, 36
storage temperature, 51
support
  Mac, 48
  Windows, 39
suspend mode, 49
system requirements, 19
  Mac, 20
system tray icons (Windows), 36

T

taskbar icons (Windows), 36